Hydrologic Modeling using HEC-HMS

Prepared by
Venkatesh Merwade
School of Civil Engineering, Purdue University
vmerwade@purdue.edu

April 2007

Introduction

The intent of this exercise is to introduce you to the structure and some of the functions
of the HEC-Hydrologic Modeling System (HEC-HMS), by simulating the runoff
hydrographs resulting from a design storm on Waller Creek in Austin, Texas. This
exercise involves the study of extreme discharges on Waller Creek using rainfall-runoff
analysis. The physical parameters describing the watershed were developed previously
using a GIS program (PrePro) available at
http://ceprofs.tamu.edu/folivera/GISTools/PrePro2002/PrePro2002.htm. A GIS pre-
processing tool called HEC-GeoHMS, available from U.S. Army Corps of Engineers can
also be used for this task. HEC-GeoHMS is available at:
http://www.hec.usace.army.mil/software/hec-geohms/

A tutorial on how to use the newer version of HEC-GeoHMS that works with the latest
version of ArcGIS is available at: http://web.ics.purdue.edu/~vmerwade/tutorial.ntml

Computer Requirements

You must have a computer with the latest windows operating system, and HEC-HMS
3.1.0 installed.

HEC 3.1.0 for windows is available for free from the Hydrologic Engineering Center's
home page at: http://www.hec.usace.army.mil/software/hec-hms/download.html. A user's
manual is also available at this location. (Purdue Students: The program is loaded on
computers in ITaP’s JNSN B012 lab)

Data Requirements

To run HEC-HMS model, a basin file is needed to specify the physical parameters of the
watershed, and a map file to give the outline of the drainage areas and creeks. These files
for Waller creek (zipped as waller.zip) can be downloaded from the following link:

http://web.ics.purdue.edu/~vmerwade/education/waller.zip
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Make a working directory on your computer and download waller.zip, and unzip its
contents. .

Getting Started

Start HEC-HMS by clicking on the HEC-HMS icon by going to

Start 2Programs 2HEC-HMS HEC-HMS 3.1.0 (Purdue students doing this tutorial in
an ITap Lab may have to first run the set-up file by going to Start *Programs >Course
Software >Engineering 2HEC-HMS HEC-HMS 3.1.0)

After a few seconds, the following should appear:

B HEC-HMS 3.1.0 FEX

File Edit Wiew Components Parameters Compute Results Tools Help

Watershed
Explorer

Component
Editor

Message Log

Henceforth, this window will be referred to as HMS Interface. The HEC-HMS interface
consists of a menu bar, tool bar, and four panes. These panes are referred to as the
Watershed Explorer, the Component Editor, the Message Log and the Desktop. More
description on these panes, menus and tools is provided when they are used later in the
exercise.

Creating a new HEC-HMS project



The first step is to create a new HEC-HMS project by selecting File->New in the menu
bar. Enter the project name and description as shown below, and specify your working
directory (where waller.zip is downloaded).

Create a New Project E|
Mame: | Waller
Description: | Introduction to HEC-HMS at wwaller Creek, :E
Locakion: | H:iWaller (=
Cefault Unit System: |Metric w
[ Create ] [ Cancel ]

Click Create to create the Waller project.
HMS Model Components

HMS has four main model components (you can see these by selecting components on
the menu bar): basin model, meteorologic model, control specifications and input data
(time series, paired data and gridded data). The Basin Model, for instance, contains
information relevant to the physical attributes of the model, such as basin areas, river
reach connectivity, or reservoir data. Likewise, the Meteorologic Model holds rainfall
data. The Control Specifications section contains information pertinent to the timing of
the model such as when a storm occurred and what type of time interval you want to use
in the model, etc. Finally, the input data component stores parameters or boundary
conditions for basin and meteorologic models. Each of the sections is explored below
individually

Importing a Basin Model

The first of the Components we will consider is the Basin Model. To create a hydrologic
model of Waller Creek, you need to import the basin file that you just downloaded. In
HMS interface, use File 2Import -Basin Model... Browse to Waller_Ck.basin in the
working directory, and click Select to add it to the HMS project. To see the Waller Creek
basin model in the Desktop window, expand (by clicking on the + sign) the folders in the
Waller folder until you get to Waller_Ck as shown below.



Ed HEC-HMS 3.1.0 [H:Waller\Waller\Waller. hms]
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D B3¢ aévwaPe Dy % B 0w
_4 waller il 7. Basin Model [Waller_Ck]
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Name: Waller_Cck
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If you expand Waller_Ck, you will see different hydrologic elements in the basin in the
watershed explorer. Before we get into the details of the basin, go ahead and add the
basin map which is stored in the Hms.map file.

In the HMS interface, select View—>Background Maps. This will prompt a Background
Maps window. In the Background Maps window, click on Add... Browse to the
Hms.map file in the working folder (make sure you change the Files of type to HMS Map
File (*.map) as shown below), and select it.

Files of bype: | s Map File (*.map) L

e 1| Fil2s

11535 Digital Line Graph File (*.dlg)
AukaCad Interchange File (*.dxf)
Geo-Referenced Image (%.img)

HMS Map File (*.map)
ESRI shapefile (*.shp)

This will add Hms.map in the Background Maps window. Click OK to add it to the HMS

You should then see a schematic of Waller Creek showing the watershed and stream map
and an overlay of the hydrologic elements. You will notice that the whole map of the
basin does not fit in the Desktop window. You can change the Desktop settings by
selecting View—>Maximum Extents in the Menu bar. Select the display method as Union
of All Maps and Elements with an element buffer of 40 % or more as shown below:



X
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Method: |Union OF all Elements W

Manual view exkents

Element buffer
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I Ok H Cancel ]

Now you should see the whole basin in the desktop window. Save the project.

Navigating the HMS Desktop

You can use the following four tools in the tool bar to navigate through the HMS
desktop:

LI WY

The arrow tool - X lets you select any hydrologic element in the basin. You can use the
zoom-in tool & to zoom-in to a smaller area in the desktop, and zoom-out tool & to

zoom out to see a larger area. The pan tool < can be used to move the display in the
desktop. Go ahead and experiment with these buttons to understand better how each
works.

Now lets explore the basin information.
Hydrologic Elements
The Waller_Ck basin contains different hydrologic elements. The following description

gives brief information on each symbol that is used to represent individual hydrologic
element.

&, . ; .
=* Subbasin — Used for rainfall-runoff computation on a watershed.



& Reach - Used to convey (route) streamflow downstream in the basin model.

=/ Reservoir — Used to model the detention and attenuation of a hydrograph caused by
a reservoir or detention pond.

P

Junction — Used to combine flows from upstream reaches and sub-basins.

+

=" Diversion — Used to model abstraction of flow from the main channel.

2 Source — Used to introduce flow into the basin model (from a stream crossing the
boundary of the modeled region). Source has no inflow.

+
= Sink — Used to represent the outlet of the physical watershed. Sink has no outflow.

The model of Waller Creek contains only 4 of these kinds of elements. There are 18
hydrologic elements in the Waller Creek model, made up of 7 subbasins, 5 river reaches,
5 junctions, and 1 sink at the point where Waller Creek flows into the Colorado River.
Notice that when a stream flows through a watershed, the additional local runoff from the
drainage area around the stream is not accounted for until the downstream end of the
reach where its flow is combined at a junction with the flow coming from the upstream
reach. The junctions have been located at points where roads cross Waller Creek.

Editing a Basin Model

Make sure the Waller_ck basin is expanded in the watershed explorer to see all the

hydrologic elements in the basin. Select the Arrow tool X from the tool bar, and click
on sub-basin 12 icon in the watershed explorer. After this sub-basin is highlighted,
information related to this sub-basin will appear in the component editor window (lower
left corner).

(S Subbasin | Lass | Transform | Options

Basin Name: Waller_Ck
Element Name: 12

Description: | 43 ]
Dowenstream: | Junckion with Hemphill L @
Area (kM2)y | 3.602
Loss Method: | Initial and Constant e
Transform Method: | SCS Unit Hydrograph w
Baseflow Method: |--Mone-- e



Remember the sub-basin element is used to convert rainfall to runoff. So the information
on methods used to compute loss rates, hydrograph transformation and baseflow is
required for each sub-basin element. The loss method allows you to choose the process
which calculates the rainfall losses absorbed by the ground. Click (do not select any!) on
the drop down menu to see your choices. Some options are SCS Curve No. and Green &
Ampt. In this model, Initial and Constant has been selected. This loss relationship means
that a quantity of rainfall will be absorbed by permeable soil initially, and a constant rate
will be absorbed over the time frame of the model. The loss method will convert the
rainfall hyetograph to excess rainfall (chapter 5 in the text book).

The Transform method allows you to specify how to convert excess rainfall to direct
runoff. Again, click on the drop down menu to view your options. You may remember
these options from class notes (chapter 7 in the text book). This model employs the SCS
technique (dimensionless unit hydrograph in Chapter 7). The modClark model takes
gridded rainfall data, subtracts the losses as specified through the Loss Rates, and
converts the excess rainfall to a runoff hydrograph using a variation of what is known as
the Clark unit hydrograph. There is no baseflow method specified for this model, but you
can look at the available options. If we specify baseflow, this baseflow will be added to
the resulting direct run-off hydrograph to produce total streamflow hydrograph.

Once the loss and transform methods are chosen for the sub-basin, the next step is to
specify the parameters for these methods. Select the Loss tab in the component editor to
look at the parameters for the loss method.

\& Subbasin | L@ss | Transform | Options

Basin Name: Waller_Ck
Element Name: 12

Initial Loss (MM} | 5
Constant Rate (MMHR) | 2

Impervious {3) [ 0.0

Each sub-basin requires an initial loss quantity, a constant loss rate, and a percent
imperviousness. These values have been selected arbitrarily. If the % impervious value
differs from 0, that % of the land area is assumed to have no losses and the loss method is
applied only to the remainder of the drainage area

Similarly select the Transform tab to look at the parameters for the transform method.

15 Subbasin | Loss | Transfarm | Qptions

Basin Mame: Waller_Ck
Element Name: 12

Lag Time (MIM) | 193,515




Note that the SCS unit hydrograph method requires only one parameter for each sub-
basin: lag time between rainfall and runoff in the sub-basin. The parameter that is
specified here is t,, and the program will compute T, (time of concentration) and g,(peak
flow) to rescale the SCS dimensionless unit hydrograph (Chapter 7). This is then used to
compute the direct runoff hydrograph for this sub-basin.

The Options tab is used to enter observed streamflow and stage data which is left blank
for this model.

After the sub-basin element, lets look at a reach element. Click on reach 10, and look at
its parameters in the component editor.

"+ Reach | Routing | Optians

Basin Mame: Waller_Ck
Element Mame: 10

Description: | 90

Daovwnstream: | MLE

o

Fouting Methad: | Muskingu
LossiGain Method: | --MNone--

<€

Since the reach element route flows, only one method (routing) is associated with it.
Click on the drop-down menu to look at choices available for routing flows. The
Muskingum method is specified here, which is the routing technique used for the reaches
in this model. Routing is described in chapters 8-10 in the text book.

Select the Route tab to look at the parameters for the routing method (Muskingum).

A+ Reach | Routing | Options

Basin Mame: Waller_Ck
Element Mame: 10

Muskingurm K (HR) | 0.8583
Muskingurm % | 0,15

Subreaches; 2B

This simulation routes the water through the reaches by the Muskingum method in which
K is the travel time of a flood wave passing through the reach, X is a measure of the
degree of storage (X = 0 means a level-pool reservoir or maximum storage, X = 0.5
means a pure transmission reach in which there are no storage effects, and X ranges
between 0 and 0.5). The reach is divided into a number of subreaches if necessary to
keep the computations numerically stable.

You can explore the junctions, source and sink elements to see how they are specified.



There are a couple of ways to look at Basin model. If you expand the sub-basin model
(by clicking the + sign next to it) in the watershed explorer, you will see the methods
specified for the sub-basin, and when you click on the method, you see the parameters in
the component editor. Alternatively, you can look at the parameters for all hydrologic
elements by selecting Parameters in the menu bar and selecting a method. For example,
by selecting Parameters—> Transform—->SCS Unit Hydrograph gives a list of lag times for
all the sub-basins in the model as shown below:

i##. SCS Transform[Waller_Ck] B

Show Elements:

Subbasin Lag Time
(MIM)
12 193,813
13 320.53
14 B6.547
15 53,3529
16 104,706
17 49,4554
13 43.25

[ Apply H Close ]

Creating a Meteorologic Model

Having established the Basin Model, we will now create the Meteorologic Model. The
precipitation and evapotranspiration data necessary to simulate a watershed are stored in
the meteorologic model. From a statistical study of extreme storm rainfall data recorded
at gages, tables and maps have been prepared for the whole US which specify the storm
precipitation depth to be expected as a function of the return period of the event and the
duration of the rainfall. A table of such values is shown below for Travis County, in
which the City of Austin is located. For example, for a 10 year return period event, we
expect that in 5 min 0.85" of rainfall will fall, in 15 min 1.66", and so on, up to 720 min
(12 hours) and 1440 min (24 hours). These precipitation depths are the values which
would be equalled or exceeded on average once in 10 years when considering a very long
period of data. As rainfall duration increases, the cumulative depth of rainfall increases
but the average intensity over the duration decreases because severe rainfall cannot be
sustained for very long.



Design Precipilation Depths for Travis County, Texas (in)
Return Period (yr)

Duration {min) 2 5 10 25 50 100
5 060 075 085 098 1.07 1.24

15 145 1.47 1.66 1.93 212 243

60 1.94 255 291 341 3.80 431

120 236 13 257 421 474 535

180 2 60 347 398 471 534 502

360 305 411 475 565 645 728

720 354 487 5.57 571 175 569

1440 406 567 HE2 7.94 926 1039

We will input the rainfall to HMS in English units (inches). To import an existing basin
or meteorological model, one can use the menubar by selecting File->Import (like you
did for the basin model). To create a new model, we use Components menu. To create a
new Meteorologic Model, select Components—>Meteorologic Model Manager. In the
Meteorologic model manager, click New and enter the following information:

Create A New Meteorologic Model E|
fame :| Met 1
Descripkion :| 10 Year Design Storm| E
[ Create l [ Cancel ]

Click Create and close the Meteorologic model manager. This will add Meteorologic
Models folder to the watershed explorer. Expand the Meteorologic Models folder, and
select the Met 1 model as shown below:

+_| Easin Models
=M J Meteorologic Models
o .}%ﬁ Mek 1

Once the Met 1 model is selected in the watershed explorer, its details will appear in the
component editor. The description box includes the description you entered earlier when
creating the model. By default, the precipitation data type is Specified Hyetograph (which
is the most common data type). In this exercise, however, we will use design
precipitation data for Travis County. From the drop-down menu for precipitation, choose
Frequency Storm, and specify US Customary units as shown below:

10



Description: | 10 Year Design Storm I5

Precipitation: |Frequency Skorm w

Evapotranspiration; |--Mone--
Snowrmelk;

age Weights

Gridded Precipitation
Inverse Distance

525 Skorm

Sperified Hyetograph
Standard Project Sharm

Unit Syskern:

Similarly select the Basins tab and specify Yes to include sub-basins. Once we specify
the precipitation type, the next step is to enter the data. Unlike Basin model, there is no
extra tab in the component editor to enter the data after you choose the precipitation type.
To enter the data, you need to expand the Met 1 model in the watershed explorer and then
choose the precipitation type (Frequency Storm) as shown below:

= A Meteorologic Models
S et 1

l—:‘f}'ﬁ' Frequency Starm

Cotnponerits I Cn:nmputel Hesurtsl

This will prompt a precipitation tab in the component editor. Fill in the values shown in
the Travis County table above for a 10 year storm (10% chance of being equalled or
exceeded in any year). The storm is configured by selecting the exceedance probability
(10 % or 10 year return period), output type (Annual duration), duration of maximum
intensity (5 mins), storm duration (one day), and percentage of storm that occurs before
the peak intensity (50 %) as shown below:

Precipitation

Name: Met 1
Probability: | 10 Percent
Cukput Type: | Annual Duration
Intensity Duration: |5 Minutes

Storm Duration: |1 Day

0

Inktensity Position: | 50 Percent
Storm Area (MI2)
5 Minutes (IM) | 0.85000
15 Minutes (IM) | 1.6600
1 Hour {IM) | 2.9100
2 Hours (IM) | 3.5700
3 Hours (IM) | 3.9800
& Hours (IM) | 4.7500
12 Hours (I} | 5.5700
1 day (IN) | 6.5200

11



Save the project. For each project, the HMS creates an output Data Storage System DSS
file which stores calculated data from all runs for a given project so that results from a
previous run can be directly compared to results from a more current run.

Defining the Control Specifications

The final task in the model setup involves establishing the model's time limits. Select
Components—>Control Specifications Manager. Select New in the control specifications
manager and type the following information:

Create A New Control Specifications

Mame :| Contral 1

Description ¢ 3 Day Sinulation an Waller Creek, E

[ Create H Cancel ]

Click Create and close the control specifications manager. This will add a Control
Specifications folder in the watershed explorer. To see the control specifications file,
expand the folder, and select Control 1

_| Easin Models
-] Meteorologic Models
=~ q Control Specifications

This will prompt the control specifications tab in the component editor. Specify the
duration of the simulation in date and time, and also the time interval of the calculations
(10 minutes) as shown below:

% Caonkral Specifications

Mame: Control 1

Descripkion: | 3 Day Simulation an waller Creek :g

Start Date (ddrrry | 11APRZ007
Start Time (HH:mm) | 00:00

End Date (ddrMmpyeeyy | 14APR2007
End Time (HH:mrmy | 00:00

Time Interval: | NS

12



In this case, the duration is arbitrary; long enough to depict the runoff from a 1-day
storm, but the 10 minute time interval is part of the Basin file model setup and should
remain fixed for this Waller Creek model.

Executing the HMS Model

Finally, you have finished perusing the data involved in creating the Waller Creek model.
The last step is to run the model. Select Compute-> Create Simulation Run. Accept the
default name for the run (Run 1), click Next to complete all the steps and finally Click
Finish to complete the run. Now to run the model, select Compute -Select Run 2Run 1,
and then go to Compute 2*Compute Run [Run 1] to see the following window

(alternatively you can click the compute run tool 3 in the tool bar):

Finished Computing “Run 1*

Basin: Waller_Ck  Met: Met 1 Control: Contral 1

Close

Click Close. You will see a log in the message log as program executes the model. If
there are errors in the model, you will see them in red color. For this model, there are no
errors.

If you want to make runs with alternative model files, you can do so by first
creating/importing new model files (basin, Meteorologic and control specifications),
creating a new run (say Run 2) by going to Compute-> Create simulation run and
selecting the new files while creating Run 2. Though the model used in this exercise has
one dataset each for basin, meteorology and control specifications, HMS is slick in that it
allows the user to have multiple data sets available to include conveniently in different
runs.

Viewing HMS Results

The HMS allows you to view results in tabular or graphical form. To view a global
results table, select Results=>Global Summary Table (alternatively you can click the

Global Summary tool 53 in the tool bar). You will get a window like the one shown
below which summarizes the peak discharge and time, the total volume of storm runoff
and the drainage area from which it came.

13



Project: Wwaller Simulation Run: Run 1
Start of Run:  11Apr2007, 00:00 Biasin Model: Waller_Ck

End of Run:  14Apr2007, 00:00 Meteorologic Model:  Mat 1
Compute Time: 094pr2007, 13:02:02 Control Specifications: Control 1

Yolume Units: (3) MM () 1000 M3

Hydrologic | Drainage Area | Peak Discharge Time of Peak, Yolume

Element (KM2) (M3}3) (GG
10 10,514 44.0 114pr2007, 17:10 117.07
11 11,450 44,2 114pr2007, 17140 117.11
12 3,602 21.3 11Aprz007, 15:30 117.27
13 6.912 276 11Apr2007, 17:30 116.97
14 0,966 12,8 114pr2007, 13110 117.51
15 0.563 3.1 11Aprz007, 13:00 117.55
15th St 12,043 44.5 114pr2007, 17:40 117.13
16 1,633 15.8 114pr2007, 13:50 117.45
17 0,437 7.0 11Aprz007, 12:50 117.56
13 0.252 4.4 114pr2007, 12:50 117.58
1sk 56 14113 44,3 114pr2007, 1920 117,18
7 12,043 43.6 11Apr2007, 15:40 117.13
7th 5k 13,676 44.6 114pr2007, 18:40 117.17
3 13676 44,2 114pr2007, 19120 117,17
el 14.113 44.0 11Apr2007, 19:40 117.15
Colorada Ri... 14,365 44.0 11Apr2007, 19:40 117.19
Junction wit, ., 10,514 44.9 114pr2007, 16:20 117.07
MLE 11.430 44.6 11Apr2007, 17:10 117.11

In addition to viewing global results, you may also view results for each element within
the model. Again there are a couple of options to do this, and each option provides output
in different ways. One option is to use the watershed explorer and component editor tab.
To view results, you select the Results tab in the watershed explorer, expand the
Simulation Runs folder, and expand Run 1. To see results for any element, expand that
element as seen below:

) Waller
=4 Sirmulation Runs

= ?}ﬁ Fun 1

[Eg) Global Summary

+|&, 10

= Ig,-r 1z

----- 2] summary

----- Oukflion

----- Incremental Precipitation
----- Excess Precipitation
----- Precipitation Loss
----- Direct Runoff

----- Baseflow

+ é” 13

..... é” 14

Camponents | Compute | Resylks

To see the outflow from sub-basin 12, you can select outflow and see the outflow
hydrograph in the component editor as shown below:

14
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Similarly you can look at other graphs in the component editor by selecting the variable
in the watershed explorer. You can select a reach element and see the attenuation in the
inflow and outflow hydrograph by selecting the combined inflow and outflow option in
the watershed explorer. Each element also has a summary option that gives the results
from the global summary table (a single row of the table) for that particular element.

Another way of looking at results is by using the tools on the tool bar, which show results
in a different way than the component editor. However, to use these tools, you need to
select the element by using the component tab in the watershed explorer. For example,
select Colorado River (Sink) in the watershed explorer, and click on the view graph tool
ks ¢ get the following graph:

15



Graph for Sink "Colorado River®

Flow (h1375)
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Legend

Fun:RUM 1 Bement:ZOLORADD RIVER Result: Outflaw
— — — Run:Run 1 Bement: 18 Re=alt:Outflow
------ Run:Run 1 Bement:9 Fesult:Outflow

The dashed line hydrographs are the inflow data from the sub-basins immediately
upstream of the Colorado River which is added to the routed flow in the channel to
produce the total outflow curve. If you click on a sub-basin (12), you see the rainfall at
the top and the runoff at the bottom as shown below:

Graph for Subbasin *12*

Subbasin Element "12" Results for Fun "Fun 1"
= 07
= 107
-E‘ 207
0] .
s a0
20
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=
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o000 1200 0000 1200 0000 12:00  0m0oo
| 1iaprecoz 128012007 134pr2007
Legend
B R UM 1 Bement:12 Result: Incremental Precipitation
B cRUN 1 Hement:1Z Fesult: Precipitation Loss
Fun:RUM 1 Bement:12 Result: Qutflow
— — — Fum:RUM 1 Bement:12 Fesult:Baseflow
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Unlike a single graph in the component editor, you get to see all graphs (input
precipitation, outflow hydrograph, baseflow, precipitation losses) in a single window
using this option. You can also see the results in tabular form by using the view time
series table tool & in the toolbar. These functions are also accessed through the Results
menu on the menu bar.

OK, you are done with learning the basics of HEC-HMS for event based modeling. The

following sections are designed to use your skills in doing some hydrologic design
analysis and create new model from scratch.
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1. Waller Creek Diversion Design Study

The citizens of Austin approved a bond issue during 1998 which authorizes the City to
borrow approximately $25 million for the construction of a flood diversion tunnel for
Waller Creek. At present the 100 year flood plain for the creek covers many city blocks
in downtown Austin. The goal is to make this area safer from floods and also to
encourage the development of a river walk area, perhaps similar to that in San Antonio.
Assume that you are the hydrologist whose job it is to determine the design discharge at
the inlet point of this tunnel which is just on the downstream side of 15th Street. At this
point an overflow weir will divert a significant part of the flood discharge and convey it
to Town Lake in a 20 ft diameter tunnel.

Recompute the flows from the HMS model using the 100 year design storm instead of the
10 year design storm. How much water would have to be diverted at 15" street if the
diversion tunnel is to reduce the peak flow at 15" during a 100 year storm to the level
that it has now during a 10 year storm?

Recompute the flows from the HMS model using a 2-year, 5-year, 25-year, and 50-year
storms. Make a plot showing the peak discharge to be expected from these events at 15"
St as a function of the storm severity from 2-years to 100-year return periods.

To be turned in: A graph and a table showing the relationship between flood peak

discharge and return period for Waller Creek at 15" St. Determine the flow diversion
needed at 15" St to reduce the natural 100 year flow to the 10 year discharge level.

18



2.0 Create a simple model to create a runoff hydrograph.

An 8-mi® watershed has a time of concentration of 1.0 hour. Use HEC-HMS to determine
the direct runoff for a storm (rainfall hyetograph given below) using SCS Unit
Hydrograph method.

Date and time Excess Rainfall (in)

01/01/2002 00:00 0

01/01/2002 00:10 0.6

01/01/2002 00:20 0.4

01/01/2002 00:30 0

01/01/2002 00:40 0

01/01/2002 00:50 0

01/01/2002 01:00 0

Hint:

1. You must create new basin, Meteorologic and control specifications file either in the
same project or a new project.

2. 'You will need only one sub-basin element in the basin file with area and SCS
hydrograph details. You only need transform method. Specify None for loss method
(input provided is excess rainfall) and baseflow.

3. The input to Meteorologic file involves using the Time Series Data Manager from the
Components menu. This will add Time-Series data folder in the watershed explorer
and you will expand this folder to specify the rainfall hyetograph. When you edit the
Meteorologic model in the component editor, you will use the Specified hyetograph
(default method) method. You will then click on the specified hyetograph option in
the watershed explorer and link the time series data to the Meteorologic model.

4. In the Control Specifications model, use 10 min time interval and the simulation time

as 12 hours (end time = 12 hrs past start time).

To be turned in: A graph and a table showing the outflow hydrograph.
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